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GETTING STARTED
Introduction
Obsolete Metrics Plugin adds to MagicDraw the deprecated metrics feature.

The deprecated metrics feature allows you to measure your project from three different viewpoints:

• UML model metrics

• System metrics

• Requirements metrics

Using UML model metrics, you can measure your project using package, class, and diagram measurements 
(for example, measuring the number of classes, inheritance tree depth, and so on).

System metrics analyze models using the most popular object oriented project metrics: Halstead, McCabe, 
Chidamber, and Kemerer defined metrics (for example, cyclomatic complexity and weighted methods per 
class).

Requirement metrics consist of function points and use case metrics. These two metrics groups are so 
structurally similar that use case metrics are regarded as a subset of function point metrics. Use case metrics 
measure both the number of use cases in a project and the user case analysis through selected tagged values 
(priority, for example).

The results of these analyses are displayed in a table, where you can select which metric you would like 
displayed. You can also export the metrics to a separate file.

A metric is a numeric value that measures a model or is counted according to model measuring. Each metric 
has both a lowest and highest limit specified. Metrics that fall outside of this range are marked:

• Values that are too low are displayed in a blue font.

• Values that are too high are displayed in a red font.

To start using the plugin, you must enable it.

Enabling Plugin

To enable Obsolete Metrics plugin for MagicDraw

1. From the Options menu, select Environment. The Environment Options dialog opens.
2. Click Plugins on the left side of the dialog. The list of plugins available for MagicDraw opens 

on the right side of the dialog.
3. Type “me” to select Metrics (Obsolete) in the list.
4. Click the Enable button. The value in the Enabled column changes to true.

If the highest limit equals zero, the metric is never 
marked as too high.

Obsolete Metrics Plugin is compatible with MagicDraw Architect and 
Enterprise editions.
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GETTING STARTED
Enabling Plugin1
5. Click OK on the Environment Options dialog.
6. Click OK on the Message dialog box, which prompts to restart MagicDraw to make the plugin 

available.
7. Restart MagicDraw.
The plugin is enabled.

Figure 1 -- Enabling Obsolete Metrics Plugin
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USING OBSOLETE METRICS 
PLUGIN
Creating Metric Suites
You can create your own metric suites or use one of the three predefined metric suites: System Metrics, UML 
Model Metrics, or Requirements Metrics.

The metric suite contains a list of metrics that will be counted and the properties specified for each selected 
metric.

To create your own metric suites, clone an existing suite and specify the suite properties. You can edit the 
predefined metrics suites, and all metric suites can be imported or exported, facilitating the exchange of ideas 
with other users.

Displaying Metrics
Metrics are counted according to properties defined in a selected metric suite and can be counted for an entire 
project or just the selected packages, classes, interfaces, or diagrams. The results are displayed in the Metrics 
panel, which opens at the bottom of the application window. 

Metrics tables display packages, classes, interfaces, and diagrams. Additionally, elements that contain 
packages, classes, interfaces, and diagrams, which are displayed using a tree structure, are not counted for 
these elements.

The following is an example of a metrics table structure:

If a value is not counted for a class, interface, package, or diagram, the cell is left empty. 

You can apply the following filters to the metrics table:

• All

• Packages

• Classes (classes and interfaces are displayed)

• Diagrams

• Package Violations (only rows that contain package violations are displayed)

• Class Violations (only rows that contain class or interface violations are displayed)

When the Classes, Diagrams, or Class Violations filters are selected, the owner is displayed next to the 
following element: c1 (Classes::Package1)

Model Element Metric1 Metric2 Metric3 … …. MetricN

PackageA value value value value value value

     Inner class1 value value value value value value

     Inner class2 value value value value value value
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USING OBSOLETE METRICS PLUGIN
Starting Metrics2
Starting Metrics

To open the Metrics dialog

Do one of the following:
• On the Analyze menu, click Metrics (Obsolete) > Metrics.

• On the selected element’s (class, package, interface, or diagram) shortcut menu, point to 
Tools and then click Metrics (Obsolete).

Figure 2 -- Metrics dialog

Item Name Item Type Description
Metrics Suite Drop-down list Lists all the available metrics suites.

Calculate For Drop-down list Lists two values:
• Whole Project – calculates metrics for the entire project.
• Selection – calculates metrics for selected items only. Click the ... 

button to open the Select Elements dialog (see the following 
figure).

Metrics Options Button Opens the Metrics Options dialog.

Calculate Button Opens the Metrics window.
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USING OBSOLETE METRICS PLUGIN
Starting Metrics2
Figure 3 -- Selecting elements for calculating metrics

Packages, classes and diagrams are displayed in the Select Elements dialog box. If you select the box next to 
a parent element (for example, the Data check box in the image above), all its related child elements are 
automatically selected. Conversely, clearing the box next to a parent element clears all its related child 
elements. 

If you clear the box next to a child element, the parent box is also cleared. For example, if the Data box is 
selected, all its related child elements are selected. If you then clear the Package View box, its child elements 
are also cleared, as is the box next to Data, but all the other boxes remain selected.
8                                                                                                                                                                                                                       Copyright © 2014 – 2015 No Magic, Inc..



USING OBSOLETE METRICS PLUGIN
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Metrics panel

The Metrics panel is implemented as a JIDE GUI panel. Like the Messages panel, it is available at the bottom 
of the application window.

Figure 4 -- Fragment of Metrics panel

The following table describes the buttons of the toolbar on the Metrics panel.

The selected metrics rows or cells can be copied to the clipboard by clicking Copy on the shortcut menu or by 
Ctrl+C on your keyboard.

Item Name Item Type Description
Expand all Button Expands all the branches in the metrics results tree.

Collapse All Button Collapses all the branches in the metrics results tree.

Refresh Button Recalculates metrics results according to the current model.

Metrics Options Button Opens the Metrics Options dialog. 

Export Metrics Button Opens the Export Metrics dialog.
Learn more in "Exporting Metrics" on page 10.

Compare Metrics Button Opens the Open dialog, where you can select a text file to compare with 
the currently open metric set.
Learn more in "Comparing metrics" on page 11.

Print Button Prints the metrics table. The Print dialog opens.

Filter Drop-down 
list

Contains these values:
• All
• Packages
• Classes
• Diagrams
• Package Violations
• Class Violations
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USING OBSOLETE METRICS PLUGIN
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Exporting Metrics
You can export the selected metrics rows and columns, or the entire metrics table, to a metrics results file. 
Metrics results can be exported using *.txt and *.html formats.

To export Metrics

• Click the Export Metrics button in the toolbar of the Metrics panel. The Export Metrics dialog 
opens.

Figure 5 -- Export Metrics dialog

*.html format is best suited for viewing metrics. If you want to copy 
the metrics table to another program, use of the *.txt format.

Metrics are presented in *.txt format and are separated by tabs.

Element Metric1 Metric2 Metric3 …. MetricN

Package Package1 value value value …. Value

Class class1 (Package1::class1) value value value …. Value

Class class2 (Package2::class2) value value value …. Value

Here Metric1 .. MetricN – the metric name abbreviation.
Technical information is displayed at the bottom of the file. Text “Element IDs” are added 
after the metrics of an element and are also printed. This information is needed for 
metrics comparison
Information is presented in *.html format.
Metrics Report

Element Metric1Metric2Metric3…. MetricN

Package Package1 value value value …. Value

Class class1 (Package1::class1) value value value …. Value

Here Metric1 .. MetricN – the metric name abbreviation.
Each metric name is hyperlinked with its metric description. Metric descriptions can be 
opened in a separate window after clicking the hyperlink.

Item Name Item Type Description
Metrics Output 
File

Text box Displays the path and file names of the metrics results output file. 
Click the ... button to select the location and file.
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Comparing metrics
Counted metrics can be compared with metrics that are saved in a *.txt file. Metrics can be compared only 
when the metrics panel is open.

Comparison results are displayed in the same metrics table. If a cell contains a metric that has increased, it has 
a red fill color. If the metric has decreased, a blue fill color is used. Metrics that are not found in other file cells 
have a grey fill color.

The metrics comparison can be canceled using the ESC key.

Metrics Options
Metrics suites are managed in the Metrics Options dialog.

To open the Metrics Options dialog

Do one of the following:
• From the Analyze menu, select Metrics (Obsolete) > Metrics Options.

• In the Metrics (Obsolete) dialog, click Metrics Options.

Output Type Drop-down list Contains these values:
• Text (*.txt)
• HTML (*.html)

Export Selected 
Rows Only

Check box When selected, only the selected table rows and the header row 
are exported.
When cleared, the entire metrics table is exported.

Item Name Item Type Description
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USING OBSOLETE METRICS PLUGIN
Metrics Options2
Figure 6 -- Fragment of Metrics Options dialog

The left pane of the Metrics Options dialog displays the defined metrics suites. Using the buttons or shortcut 
menu, metrics suites can be cloned, renamed, removed, exported, and imported. Predefined metrics sets 
cannot be renamed or removed.

The suite properties are displayed on the right pane.

Metrics suite pane

The following table describes the items of the left pane of the Metrics Options dialog.

Item Name Item Type Description
Metrics suite List Displays all created metrics suites in a list.

Clone 
Rename
Remove
Import
Export

Buttons for 
managing 
items of the 
Metrics suite 
list

• Clone – clone the selected suite. 
• Rename – rename the selected suite.
• Remove – remove the selected suite.
• Import – import a new suite. The Open dialog opens.
• Export – export the selected suite. The Save dialog opens.
All these commands are available from each metric suite shortcut menu.

Select metrics to 
calculate

Tree Use this tree to select the metrics you want to include in your metrics 
suite. All metrics are displayed in the metrics tree.

Select All Button Selects all metrics in the tree.

Clear All Button Clears all metrics in the tree.
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Metric properties pane

The following table describes the metric properties.

Reset to Default Button Predefined metrics are reset to the default metrics suite.
User-created metrics suites are reset to the selected predefined metrics 
suite. The Reset Metrics Suite Properties dialog opens.

Property 
Group

Property Description

General Calculate Defines what will be counted: 
• Local – inside package (class). 
• Global - inside package (class) recursively.
• Average – metrics will be counted from the lowest level of the elements 

tree. Each upper level metric will be counted as an average of the current 
object metric and all lower level metrics:
Average_element_metric = (Element_metric_value (if counted separately) 
+ sum (inner_elements_metrics_values)) / (1 (if element_metric_value 
was counted) + count_of_inner_elements_that_have_metrics_counted)
Average metric value should be rounded down to the lower value (for 
example, 1.5 = 1, 1.6 =2)

• Min – lowest level metrics will be counted. Each upper level metric will be 
set to the minimum of the current object metric and all lower level metrics 
(except the metrics that are equal 0).
Min_element_metric = min (Element_metric_value, min 
(inner_elements_metrics_values)) 
Here metric_value > 0 

• Max – lowest level metrics will be counted. Each upper level metric will be 
set to the maximum of the current object metric and all lower level metrics.
Max_element_metric = max (Element_metric_value, max 
(inner_elements_metrics_values))
Here metric_value > 0

Lowest limit Package Recommended lowest metric value for the package. Editable.

Class Recommended lowest metric value for class and interface. Editable.

Diagram Recommended lowest metric value for the diagram. Editable.

Highest limit Package Recommended highest metric value for package. Editable. 
If the highest limit is equal to 0, the metric is never marked as too high (in red 
font color).

Item Name Item Type Description
13                                                                                                                                                                                                                       Copyright © 2014 – 2015 No Magic, Inc..



USING OBSOLETE METRICS PLUGIN
Metrics Options2
The following is an example of a metrics calculation used for calculating the number of classes (NC) in this tree:

Calculated metric values with a different aggregation:

Class Recommended highest metric value for class and interface. Editable.
If the highest limit is equal to 0, the metric is never marked as too high (in red 
font color).

Diagram Recommended highest metric value for diagram. Editable.
If the highest limit is equal to 0, the metric is never marked as too high (in red 
font color).

Include This properties group specifies whether the information is included when 
counting metrics.

Weight This properties group specifies whether the information is included when 
counting metrics.

Element Local Global Average Min Max

 Top 1 8 1 1 2

 Inner1 2 4 1 2 2

 C1 0 0 0 0 0

 C2 2 2 1 2 2

 c_in1 0 0 0 0 0

 c_in2 0 0 0 0 0

 Inner2 1 3 1 1 2

C3 2 2 1 2 2

c_in3 0 0 0 0 0

c_in4 0 0 0 0 0

C4 0 0 0 0 0

Property 
Group

Property Description
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